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1 Introduction 

Query Objects form the business meta-layer for end user reporting. Query Objects hide the physical 

database details, SQL complexities, table names etc. from the end user. A user can design smart reports, 

charts and dashboards without knowing where and how the data is fetched from the database. 

A query object contains details to fetch desired data from a data connection.  A query object acts as a data 

source to reports, parameter and Query objects.   

A query object can be a source for another query object. To be able to access query objects, you need to 

meet the below pre-requisites. 

Pre-requisites 

Ensure that currently logged in user has ‘Data Administrator’ privilege. 

The currently logged in user should have access rights granted on valid database connections on which 

query object needs to be designed. 
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2 Query Object Editor 

Let us look at the Query Object Editor in Intellicus. Below are the main sections that enable to design a 

query object. 

1. Editor or Transformation area – the central area of the Query Object Editor that represents the 

design of the current Query Object 

2. Steps Selector – the left pane from where you can drag required steps to design the Query Object 

and drop on the editor 

3. Properties tab – the bottom left tab where you can edit properties of any selected item on the 

editor 

4. Result tab – the bottom right tab where you can view data result set processed up to currently 

selected step 

5. Button palette – Action buttons on the top menu for CRUD operations 

Figure 1: Query Object Editor 

Editor section is a plain canvas.  

You can give a name to your Query Object by double clicking untitled Query Object text at the top of the 

screen.  

When you add a new Query Object, you get the already created two steps – Data Source and Format on the 

editor. 

An edge line joins the two steps, with an arrow depicting the flow of data. 

You can select a new step from the step selector and drag it on the editor and then join the step with 

another. Draw the joining line in the direction of dataflow. You can also double-click the step to place it on 

the editor. 

You can also directly drop a step on an existing edge line, to insert the new step between the two existing 

ones joined by that line. For example, to insert a filter step between Data Source and Format, drop the Filter 

step on the line. 

You can have multiple Data Source steps in a Query Object.  
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Based on standard data processing rules, some steps can take multiple inputs. 

For example, a join step can take two inputs and a Union can take more than two inputs. 

At each step you can select the Result tab to see the result data set up to selected step. This is a sample data 

set and may not be complete data. 

Figure 2: A sample Query Object 

 

Note: While designing query objects, use of reserved keywords in SQL Query (for 

column names/aliases) is not allowed. This is applicable for both, SQL queries as 

well as stored procedures. 
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3 Creating Query Objects using Simple Steps 

Let us look at the various steps that you can add onto the editor. Following are the primary steps with their 

behavior and properties explained. 

Data Source step 

The Data Source step brings data into the Query Object.  

You can bring data into the Query Object from: 

1. RDBMS source using SQL or stored procedure 

2. File source 

3. Web service 

4. Another Query Object 

5. Big Data / Non-relational databases 

 

There can be any number of Data Source steps in a Query Object. 

Each Data Source step has the following properties to set. 

 

Properties 

Property Values Comments 

New Source/ 

Existing QO 

New Source/ 

Existing QO 

You choose whether a new SQL or file source is to be 

created or you can use an existing Query Object 

Connection Select from available 

list or Select (Parent)  

When selected (Parent), then this Data Source fetches 

data from the connection specified in the Connections 

option present at the top left options bar (Refer Figure 2) 

or falls back to default connection configured for the 

user. 

When a connection name is selected, then this Data 

Source fetches data only from that connection, 

irrespective of Query Object connection or connection of 

other Data Source in this Query Object 

SQL A Complete SQL 

statement designed 

This property is visible when you select a connection 

that points to an RDBMS. 
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with the help of SQL 

Wizard 

The SQL Designer window opens for you to design an 

SQL or procedure. See the below section for SQL 

Designer details 

File/Stream 

Source 

File name, File Type and 

parsing details 

designed with help of 

File Selector Wizard 

This property is visible when you select a connection 

that points to a file system. 

The File Selector window opens to specify file name, file 

type and parsing details 

Web Service Web Service Name, 

Port, Method and 

Record Pattern details 

designed with help of 

Web Service Selector 

This property is visible when you select a connection 

that points to a Web Service. 

The Web Service Selector window opens to specify web 

service, port, method and record pattern 

Existing QO Select an existing Query 

Object 

The output of the select Query Object becomes input of 

this Data Source 

Sorted Check/Uncheck Check = You specify if this data is already sorted on one 

or more fields.  

This flag helps in optimizing sort dependent steps or 

processes later in the data flow 

Fields Lists all fields available 

in this Data Source 

The fields along with Field Properties can be set as 

discussed later 
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SQL Designer 

This wizard allows you to design SQLs by dragging and dropping tables on the Design tab or by typing the 

complete SQL on the Edit tab. 

Figure 3: SQL Designer 

 

Note: You can see the schema of database of selected connection for which metadata 

caching has been done. 

 

The SQL Designer’s left pane lists Entities and attributes in the selected entity.  The area on the right side is 

divided into following tabs: 

• Design: Use this tab to design relatively simpler queries using drag and drop method.  

• Edit: SQL designed on Design Tab is represented as an SQL statement on this tab.  You can also 

write or paste SQL here.  

• Result: Rows received as a result of SQL execution are displayed here.   

• Sort: To specify sorting preferences.   

• Filters: Set runtime filter criteria on this tab.   

• Procedure: This tab is brought in front when procedure is selected.  Specify procedure related 

details on this tab.   

Note: Use Sort tab and Filter tab only from Web Studio.  For SQL used in a Query 

Object, users will specify Sort and Filter on Ad hoc Report Designer/ Smart View. 
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Getting a list of database objects 

The top line indicates the database connection that will be used to get database objects list. 

1. Select any of the objects among Table, View, Procedure and Synonym. 

2. Entities available on selected connection are listed.  At a time, the list displays a pre-set number of 

entities. If the entity you are looking for is not available in the list, use the drop-down box options to 

view another set of entities. To get next list, click Next link. To get previous list, click Prev link. 

Date and time when metadata of the selected entity was refreshed appears on the top of the SQL Designer. 

 

SQL Designer: Design 

Simple SQL Queries can be designed using Design Tab. 

To add an entity in Select clause and From clause: 

1. Select Table, Procedure, View or Synonym.  List of entities of selected item appears. 

2. Drag the entity you want from the Entity list and drop it in design area (blank area on the right).  

It appears as a box in design area.  Entity name also appears in Select clause and From clause.  Repeat the 

above steps to select multiple entities. 

Note: Instead of drag and drop, you can also double-click an entity. You can also 

use parameters as part of the SQL. To do this, drag [PARAMETERS] to design 

area. Parameter box appears in different color. 

To re-position attribute list of an entity on design area: 

Click the title bar of the box and drag to re-position it where you wish on design area. 

To join two entities: 

Drag the field / attribute from one entity list and drop it on the field / attribute on another entity.  

An arrow will appear connecting two attributes of "From" entity and "To" 

entity.  Select, From and Where clause will also change accordingly. 

To delete a join: 

Right-click the arrow representing that join.  The Delete Link option will appear.  Click Delete Link option. 

Join will be deleted and will be removed from Where clause. 

 

Working with Attributes 

• An attribute from any entity on design area can be dragged and dropped at right place 

in Select clause, Where clause, Group By and Order By clause.  

• You can also check or clear the attribute to include it and remove it from Select clause respectively. 
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Where clause 

To get a row at the top: 

Click the  in the leftmost cell of column header.  This inserts a row below column header. 

To get a row below current row: 

Click  in the row below which you want to add a row for condition.  A row will be inserted in the row below 

the respective row. 

To remove a condition: 

Click  button in respective condition row. 

To specify a where clause 

• Form a condition by selecting operand1, operand2 and operator. 

• To join conditions, form two conditions and select a relation in rightmost column of the first 

condition (of the two being joined). 

• To group conditions, specify opening and closing braces. 

Note: You can also drag an attribute from design area to be used as operand1 or 

operand2. 

 

Group By 

In the Group By clause you can provide grouping criteria for the SQL statement.  To place an entity in Group 

By, click the entity in the Entity List and drag it in the box below Group By. 

Note: You can also drag an attribute from design area. 

 

Having 

The procedure to complete Having clause is the same as that of Where clause.  

Note: Do include appropriate summary function in select clause so that it can be 

used in Having clause. 

 

Order By 

In the Order By clause you can provide sorting (ascending/ descending) criteria for the SQL statement.  For a 

report with grouping, the order by clause must have the columns in the same order as of the respective 

sections in the Layout Editor. 

Note: You can also drag an attribute from design area. 
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SQL Designer: Edit 

On Edit tab, you can view and write complex SQL statements that cannot be defined using the Design 

tab.  From Design tab, when you come to Edit tab, the SQL in the Design tab is constructed and displayed as 

a complete SQL statement.    

You can also write dynamic SQL Queries on Edit tab.  Refer below section to know how to write dynamic SQL 

Query. 

The SQL statement in the Edit tab will be used as the final SQL for compilation. 

From Edit tab, if you switch over to Design tab, make changes and get back to Edit tab, you will be prompted 

with a dialog.  This is to prevent a complex query (defined in the Edit tab) from being over written when from 

Edit tab you switch over to the Design tab, make some changes, and return to Edit tab. 

On that dialog, select OK to reconstruct SQL designed on Design tab and replace existing SQL on Edit 

tab.  Select Cancel to retain the SQL on Edit tab and use it as the final SQL. 

 

SQL Designer: Result 

When you select the Result tab, the defined SQL statement will be compiled. Record-set (Default: 50) will be 

displayed in case of successful completion. If there was any error, same tab will display the error. This would 

help you in finding the exact location of error(s) and rectify them. 

 

SQL Designer: Sort 

• Prompt: Select this check box to get sort dialog box at report-run time. User will be able to provide 

sorting options on the dialog box. 

• Count: Select the number of sort levels to be made available to user. For example, if you want to 

provide three sort choices at run time (e.g. by Country, State and county), select 3. 

• Disable Forced Sorting: If due to any reason, result-set received from data-source is not sorted as 

per need (like groping), Intellicus server will sort the data. Check this checkbox to stop Intellicus 

from doing so. 

Important: Data sorting performed by Intellicus becomes significantly time-

intensive process when a record-set has large volume of records. In that case, we 

recommend not to Prompt and check Disable Forced Sorting. This will make sure 

Intellicus uses data as it is received from data-source. 

Under ‘Select Sort Fields’, the fields listed in Available Fields are the fields that will come from database. The 

fields listed in Selected Fields will be available for sorting at run time. 

• To move a field from Available Fields list to Selected Fields list, select a field from Available 

Fields list and click > 

• Click >> to move all the fields to Selected Fields list 

• To move a field from Selected Fields list to Available Fields list, select a field from Selected 

Fields list and click < 

• Click << to remove all the fields from Selected Fields list 
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Qualifier: When SQL is typed in Edit tab, fields may not be prefixed with table name and so, Available Fields 

list also don't have table names prefixed. Select a field and specify table name to associate it with a table. 

This is especially useful when you get the same field name from two tables and wish to differentiate one 

from another. 

Based on the number selected in Count check box, that many dropdown boxes will appear on an input form 

at the run time. You can select fields that should appear by default along with default order (ascending or 

descending). 

In Default Fields select the field, and the sort order. Click  button to delete that row.  

 

SQL Designer: Filters 

At report run time, a user may wish to receive the data that makes sense to him/her at that time. On this tab, 

you can set filters so that user can provide filter values at report run time. 

To add filters: 

Select a field from Available Fields. Click > button to move the fields to Selected Fields list.  At report run 

time, Ad hoc tab of Input Parameter Form will have 3 rows having all the selected fields as dropdown.  Use 

>> to move all the fields to Selected Fields list. 

To un-select a field, click the field from Selected Fields list and click < button. Click << button to empty 

Selected Fields list. 

• Qualifier: When SQL is typed in Edit tab, fields may not be prefixed with table name and so, 

Available Fields list also don't have table names prefixed. Select a field and specify table name to 

associate it with a table. This is especially useful when you get the same field name from two tables 

and wish to differentiate one from another. 

• Max Rows: The maximum number of records to be fetched from the database. Number specified 

here would appear by default on input parameter form at run time. User can change it if required at 

run time. 

• Suppress Duplicates: Check this checkbox to get only one record if record has multiple records 

having completely duplicate values. 

 

To get a row at the top: 

Click the  in the leftmost cell of column header.  This inserts a row below the column header. 

To get a row below current row: 

Click  in the row below which you want to add a row for condition.  A row will be inserted in the row below 

the respective row. 

To remove a condition: 

Click  button in respective condition row. 

Specify / select values the selected field from other columns.  Details are provided after these steps. 
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• FieldName: The field name for which default value(s) is being set. 

• Type: Select Ad hoc to use the fieldName for accepting the value.  Select UserParameter get value 

using a pre-set user parameter. 

• Data Type: Specify data type of the filter parameter. 

• Parameter: If Type is UserParameter, specify the parameter name. 

• FetchData: Select this check box for the field if filter type is Ad hoc and you want data should be 

fetched from the database.  In this case value box for this field will appear as a drop-down box. 

• Criteria: Select criteria for the field. 

• Value1, Value2: Based on selected criteria, specify Value1 or Value1 and Value2.  For example, for 

“Between” as criteria, you need to provide two values. 

• Mandatory: Select this checkbox if it is mandatory for user to provide value for this field at runtime. 

 

SQL Designer: Procedure 

To set procedure and provide value of parameters if any: 

• Click Procedure tab to bring it in front. 

• Click Procedure from the box listing database object types.  Procedures are listed in Entities list. 

• Double-click an entity (procedure) to select it.  Procedure Name appears in Procedure 

Name area.  Parameters in that procedure appears in the Parameter list. 

• For each entry (parameter), specify a constant value or parameter name. 

  

Dynamic SQL Query 

Using parameters: 

To include a parameter in the SQL Query, specify a parameter enclosed within <% and %>. 

Example: To dynamically decide where clause: 

SELECT * FROM EmpTbl WHERE prmManufacturer = '<%PrmWhrCls%>';   

  

Using javascript code block: 

Use javascript code block enclosed by <@% and %@> to create a dynamic SQL Query.  After execution, the 

code block should return a string that will be replaced in the SQL query. 
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You can use following in the code block: 

• if else 

• parameter value and parameter data type 

Syntax of code block: 

<@% 

[Executable block, which returns a string] 

%@> 

Syntax to use parameter in code block: 

params("parameterName").getAttribute() 

Attributes: "Value" to get value of the parameter and "DataType" to get data type of the parameter. 

Examples 

Example 1. Check if parameter "prmEmpNo" exists. If it does and its value is not blank, return the value, else 

return nothing. 

Select * from emp where 1=1 

<@% 

if(params("prmEmpNo") != null &&  

params("prmEmpNo").getValue() != "") 

{ 

return " AND empno in <%prmEmpNo%>"; 

} 

else 

{ 

return ""; 

} 

%@> 

Example 2. Check if parameter "prmSelectTable" exists. If it doesn't, return table name as "emp" else (if it 

exists) value of the parameter to be used as table name. 

Select * from  

<@% 

if(params("prmSelectTable") == null) 

{ 

return "emp"; 

else 

return params("prmSelectTable").getValue(); 

} 

%@> 
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Example 3. Construct WHERE clause dynamically (for LOCATIONTYPEID and REGNID fields). 

select LOCTIONID, LOCTIONNAME,LOCTYPEID,REGNID from LOCATIONMASTER where 1=1 

<@% 

var v_Str; 

v_Str = ''; 

var v_Str1; 

var v_Str2; 

var v_Str1=''; 

var v_Str2=''; 

if(params("prmloctype") != null &&  

params("prmloctype").getValue() != "") 

{ 

v_Str1 = " AND LOCATIONTYPEID in (<%prmloctype%>)"; 

} 

else 

{ 

v_Str1 = ""; 

} 

if(params("prmRegion") != null &&  

params("prmRegion").getValue() != "") 

{ 

v_Str2 = " AND REGNID = <%prmRegion%> "; 

} 

else 

{ 

v_Str2 = ""; 

} 

v_Str = v_Str1 +v_Str2; 

return v_Str; 

%@> 
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File as a Data Source 

This wizard allows you to select a file and provide parsing properties to fetch records from that file. 

Figure 4: File as a Data Source 
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Web Service as a Data Source 

This wizard allows you to select a web service available from the connected Web Service provider and 

provides method, record pattern details. 

By reading the WSDL, it also prompts for parameters required to request the Web Service. 

Figure 5: Web Service as a Data Source 

 

Note: Intellicus also supports JSON as a File Type for File and Web Service data 

sources in a Query Object.   
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Field Properties 

Figure 6: Field Level Properties 

The Field Level Properties at Data Source step are listed in the table below. 

Property Values Comments 

Data Type CHAR, 

NUMBER, 

DATE, 

BINARY 

Select the data type of the incoming data 

Data Format Format String Specify the format of the incoming data. This is useful 

only if Date or IP Address type data are incoming in 

CHAR fields but needs to be converted to Date and 

Number types for further use 

Database Time Zone Select Time zone from 

the list 

Specify the time zone in which the incoming date data 

is stored. This is useful only if date time data needs to 

be converted to other time zone data based on 

reporting requirement.  

For example, when incoming GMT data need to show 

EDT (or any requested TZ) value in report, specify that 

the incoming data is GMT. The output format is 

generally specified in Format step or in user 

preference 

Length/Precision Type yourself Length of field for Char data type 

Precision or length of field for Number data type 

Scale Type yourself Scale or number of digits after decimal point 

Locale Select from the list Select the language/ country in which the incoming 

date data is stored 
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Sort Priority Number 0-N If the data is sorted on multiple fields then specify sort 

priority number of this field. 

Primary sort field should be the lowest number 

Sort Criteria Ascending/ 

Descending 

Specify sort as either ascending or descending order 

Qualified Name Type yourself This name can be used as the field name to resolve 

field name ambiguity when same field is fetched from 

two tables or expressions 

Format step 

The Format step primarily lists all fields provided by the selected Query Object. 

The Format step generally the last step of the Query Object workflow, specifies caption, group label etc. and 

acts as business view of the Query Object. 

Figure 7: Format Step 
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For each field on the Format step, the following properties are set: 

Property Values Comments 

Field Name of Field 

(read only) 

Original name of the field. 

Source Step Name 

(read only) 

In which step did this field originate in the Query Object. 

Helps in tracking a field source in a complex Query 

Object 

Caption Type yourself This is name of the field which you can see under the 

Fields list while designing a report 

Hyperlink Hyperlink Options: 

URL 

Drill Down to another 

Report 

Detailed steps of specifying hyperlink is mentioned 

below in a separate section titled “Hyperlinking a Field” 

Group Label Type yourself or Select 

from list 

To create a new group, type the new group name. 

To put this field into an existing group, select group 

name from the drop-down list. 

This helps to categorize fields if the number of fields 

fetched from SQL is large 

Hidden Check/Uncheck Check = makes this field invisible to users for reporting 

process.  

It also hides this field from next Query Object if this 

Query Object is used as a Data Source 

GIS Enabled Check/Uncheck Check = This field has GIS classification data such as 

country names, state or city names. 

GIS enabled field will appear in selection list for 

grouping option in GIS mapping visualization screens 

Format 

properties 
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Width Number 1-100 Default width of this field when dragged onto a report 

Output Format Format String This field value will be formatted using this format 

string. 

Useful for Date and Number formatting. 

If you need to decide the format string at run time, then 

select “Apply Locale Default” property in the Format 

String selector dialog 

Align Left, 

Right, 

Center 

This field, when put on a report, its values will be aligned 

to the selected side by default 

Input Format Format String This format string decides the prompting format for the 

value for this field on Ad hoc Filter screen. 

This is useful in prompting date values in desired format. 

This is also used to input IP Address format for number 

values. 

For details on Output/Input Format, refer the below 

section titled “Data Format Dialog” 

User Time Zone Select Time zone  Specify the time zone in which the date data is to be 

converted and displayed.  

The Report Server calculates the difference between 

Database Time Zone and User Time Zone and does time 

conversion. 

For deciding User Time Zone at run time, select 

SYS_USER_TZ value. 

Render As Select from list: 

Blank 

Image 

Select Render As Image in case the string field has 

reference to an image path 

Width Type yourself Width of the rendered image  

Height Type yourself Height of the rendered image 
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Source Type Select from list: 

Image Path 

URL 

The path of the image to be rendered can be a relative 

system path (example: ../images/intellicus_logo.gif) or 

an external URL (example: 

http://www.intellicus.com/Images/Intellicus_Logo.png) 

 

Hyperlinking a Field 

A field can be made hyperlink to visit a web page or drill down to another report (parameterized report) at 

run time.  For example, 

• For a summary report having sales by country, you can hyperlink the country-name so that user can 

open respective country’s detailed sales report by clicking the country-name. 

• From within a report, select and open web sites or documents dynamically, based on values used in 

the URL. 

Figure 8: Hyperlink Options dialog box 

 

Hyperlink Options 

URL 

You can hyperlink the field to open a specific URL. 

The URL is automatically constructed by the “Drill Down to another Report” settings. 

http://www.intellicus.com/Images/Intellicus_Logo.png
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You can over write the URL on your own. 

For external links such as web links you need to write your own URL text. 

Drill Down to another Report 

This option enables to hyperlink the field to open a specific report. 

 

Hyperlink Dialog Properties 

Property Values Comments 

Select  Select Report using Report 

Selector 

Report to drill down to 

Target New Window(_blank) 

 

Same Frame(_self)  

 

Parent Frame(_parent)  

 

Parent Window(_top) 

Opens the drill-down report in new browser window  

 

Replaces the parent report and opens the drill-down 

report in the same portal tab 

 

Opens the drill-down report in new Intellicus portal 

tab  

 

Replaces the Intellicus portal and open the drill-down 

report in the same browser window. 

Report 

Parameter 

Parameter of the drill-down 

report 

Report Parameter is the parameter in the report being 

set as hyperlink.  

Report 

Parameter Value 

Field 

Select field from this report Select the field whose value is to be passed to drill-

down report as the selected parameter value 

System 

Parameter 

Select from list Select if you need to pass system parameter from this 

report to drill-down report 

System 

Parameter Value 

Field 

Select value For each system parameter you choose to pass, 

relevant values for that system parameter populates 

in the list automatically. You shall choose the desired 

value. Refer Appendix A to know about the System 

Parameter(s) and their value(s) 



25 

 

Data Format Dialog 

Data Format dialog is used to set the format of the field upon clicking  icon. As an alternate, you can 

also type-in the format string in the Output/ Input Format text box. 

Data Format dialog properties: 

Format General 

Number 

Currency 

Date 

Time 

Percentage 

Scientific 

Text 

Network Id 

Specifies various formats of data for input or output. 

 

 General No specific format to apply to the data. 

 Number Treat the data with number validations as given below. 
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Apply Locale Default = Instead of providing a fixed format here, 

pick the format from Localeconfigurations.xls for user’s current 

selected locale or the default settings 

Decimal Places = maximum number of decimals allowed in input 

padding or rounding up to these many decimals in output 

Use 1000 Separator = Yes = apply thousand separators in output 

Negative Numbers = whether to enclose in braces or prefix with 

minus  

 Currency 

 

Treat the data with currency validations as given below. 

 

Apply Locale Default = It picks the format from 

Localeconfigurations.xls for user’s current selected locale or the 

default settings 

Decimal Places = maximum number of decimals allowed in input 

padding or rounding up to these many decimals in output 

Check Use 1000 Separator to apply thousand separators in 

output 

Negative Numbers = whether to enclose in braces or prefix with 

minus 

Currency = Select currency symbol/chars to prefix 

 Date Treat the data with date validations as given below. 
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Apply Locale Default = Instead of providing a fixed format here, 

pick the date format from localeconfigurations.xls for user’s 

currently selected locale or the default settings 

Append Time = Append the time format from the 

localeconfigurations.xls and create date + time format string for 

user’s currently selected locale 

Format = Select a format string from the fixed formats’ list (Some 

formats may not be supported by the calendar control that helps 

end user to fill the date value) 

In case you need a fixed format date + time input or output 

formats, select the format strings that contain both date and 

time parts 
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 Time Treat the data as time part only. 

 

Apply Locale default = Instead of providing a fixed format here, 

pick the time format from localeconfigurations.xls for user’s 

currently selected locale or the default settings 

Format = Select a format string from the fixed formats’ list (Some 

formats may not be supported by the calendar control that helps 

end user to fill the date value) 

 Percentage 

Treat the data as percent division so multiply by 100. 

 

Decimal places = Decides number of decimal places in the output 
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 Scientific Treat the data as a big number that needs conversion into 

scientific format. 

 

Decimal places = Decides number of decimal precision places in 

the output 

 Text Process the text data according to the format string. 

 

Formats = Select format types as: 

Lower Case = Convert text into all lower case     

Upper Case = Convert text into all upper case 
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 Network ID This format is applicable on number fields. This format treats the 

number 32bit IP number and converts to respective IP display 

formats. 

 

 

Formats: Select format types as: 

IP Address (IPV4) = Converts user entered dotted quad notation 

IP address into 32-bit IP number in input fields. 

Converts 32-bit IP number into quad dotted notation of IP 

address in output fields 

MAC Address = Converts user entered MAC address string into its 

EUI-48 number in input fields. 

Converts EUI-48 number into its MAC address string in output 

fields 

 

 

Note: The path for locale configuration file is: 

Folder: <Install Dir>\ReportEngine\Config\i18n 

File: localeconfigurations.xls 

You may need to consult with your system administrator, in case you don’t have 

access to this file. 
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Filter Step 

Filter Step can be used to apply filtering conditions on specific fields of the selected Query Object. 

Filter step can take an input from any step (except Load and Format steps) and provide output to any step 

(except Data Source step) in the flow of Query Object. 

The properties tab shows two sections for a Filter step: 

1. Select Filter Criteria 

2. Fields properties  

Figure 9: Filter Step 

 

Select Filter Criteria 

You need to select available Field name, Criteria and Value to apply ad hoc filters for this step. 

Only the data that matches the filtering criteria can pass to the output from this step. 
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Fields properties 

For each selected field of the Query Object, the following properties can be set: 

Property Values Comments 

Field Select from list Select the field on which you want to apply filter 

Criteria Select from list Select the operator to be used in the filter. These are 

comparison operators based on the data type of the 

selected field (different for character, numeric or date).  

The between operator prompts for two values 

   

Value Type yourself or select 

from list 

Based on the configuration of this field in the meta layer, 

the value list appears 

Relation AND 

 

 

OR 

AND = The next condition is applied with combined 

conjunction of this condition 

OR = The next condition is applied in alternate 

conjunction of this condition 

Open/Close ( 

(( 

((( 

(((( 

((((( 

) 

)) 

))) 

)))) 

))))) 

Braces to group a set of conditions for applying 

appropriate AND/OR combination 

Use Parameter Check/Uncheck Check = When Use Parameter is checked, Value gets 

populated with parameter values for comparison 
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Additional 

Mandatory 

Filters 

Specify a number This specifies the number of filters in addition to existing 

filters that are mandatory for user to choose 

Lookup Values  

 

Check/Uncheck  Check = Whether this field provides a list of lookup 

values to apply filter on. Lookup values can be retrieved 

from a value list or from another table or query 

Note: Lookup Values is enabled for char and date type 

fields  

Mandatory Check/Uncheck Check = Will mandate reports using this Query Object to 

apply filter on this field 

Hide Check/Uncheck Check = Will remove this field for filter options. End user 

will not see this field in filter-on field list 

Lookup Details   

Key Value Field Select a field When we have Lookup values with display and value 

columns, the value should apply to filter on key field, 

instead of display applying filter on this field. 

This is a SQL optimization option. 

If you create a lookup with customerID and customer 

name and your table is indexed on customerID, then for 

the customer name field, set customerID as Key Value 

Field 

Dynamic Check/Uncheck Check = You can set a source (SQL or another Query 

Object) for the Lookup values 

Static Check/Uncheck Check = You can type in the lookup values  

Restrict to list Check/Uncheck Check = The list shown to the end user for selecting 

values for filtering should not allow typing in new value 

other than list 

Fetch Now, 

On Every use, 

Lazy, 

By Search 

Now = Fetch the values only upon saving this Query 

Object 

On Every Use= Fetch the values every time end user 

screen loads for prompting filters 

Lazy = Fetch the values when user selects this field for 

filtering and clicks the combo for value selection 

By Search = Fetch matching values when user starts 

typing values in the filter  
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Min. Key Length Number 0-4 By search fetching of data starts only after these many 

characters are typed by the user 

User Defined Check/Uncheck Check = To provide a user defined SQL or data source for 

lookup values 

Uncheck = Automatically generates distinct based query 

to get lookup values 

New Source/ 

Existing QO 

New Source/ 

Existing QO 

Whether user defined is new SQL or an existing Query 

Object 

Display Column Select from List From lookup value result set, select the field to display 

on the user interface 

Value Column Select from List From lookup value result set, select the field to pass the 

value under filters 

Link Lookup Check/Uncheck Check = Specifies that this is a nested lookup 

Link Lookup     

To Parent Field 

Check/Uncheck Check = Select the parent field to which this field will be 

nested. 

For example, Set Country as the parent field for this 

property of State field   

Note that you must use the parent value in the where 

clause of lookup SQL 

Link Lookup      

Mandatory 

Check/Uncheck Check = Before applying a filter on Parent field, the 

nested field lookup values will not be listed 

Uncheck = Before applying a filter on Parent field, ALL 

values will be listed for nested field. When a filter is 

applied on parent field, NESTED values will be listed 
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Sort Step 

Data that passes through a Sort step gets sorted based on the properties like Sort By Field, Criteria, etc. as 

specified in the step. 

Figure 10: Sort Step 

The properties to set are: 

 Property Values Comments 

Sort by Field Select field from list You can add multiple fields using Sort by and Then by 

lines based on priority of sorting in the order they are 

applied 

Criteria Ascending/Descending Sorting criteria as either ascending or descending 

order 

Case Insensitive Check/Uncheck Check = ABC is at same level as ABc 

         XYZ is smaller than abc 

Uncheck = ABC is smaller than ABc 

         XYZ is bigger than abc 
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Formula Fields Step  

Formula Fields step allows you to add calculated fields that are populated at run time. These calculated 

fields are generally based on existing fields. In the below figure, interest amount is calculated applying a 

formula on the fields of the selected data source. 

Figure 11: Formula Fields Step 

 

Action Button Comments 

Add  To add a new formula field 

Delete  To delete the selected formula field 

For each added formula field, following properties are set: 

Property Values Comments 

Name Type Yourself Name of the field as visible to the end user 

Return Type Number 

Char 

Date 

Determines the data type of the formula field 

Length/Precision Type yourself Length of field for Char data type. 

Precision or length of field for Number data type 

Scale Type yourself Scale or number of digits after decimal point 
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Formula Formula String Java script syntax formula 

 

 

Formula String Syntax 

Follow JavaScript Syntax to create a formula.  To create a formula, you can use field names and define 

variables. A formula may have 'if' construct as well as 'nested if' construct. You can use logical operators 

too. If want to add more than one statements in formula, use semicolon ';' as separator between two 

statements. 

Example: 

For a formula field named TotalAmount,  

var total ;  

if (unitprice < 10 )  

{total = unitprice*quantity;}  

else  

{total = unitprice;}  

TotalAmount = total; 
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Specifying Actions from the Button Palette 

The various menu actions that can be performed on the Query object are described in the below table. 

Item Action 

Add New Closes currently opened Query object and provides a new screen for designing 

an Query object 

Open Opens a selector dialog to select and open a Query Object for editing. To open 

a Query Object, expand the folder and either double-click or click the Query 

Object name and click Open. 

List View shows the list of Query Objects 

Detailed View shows the detailed view of Query Objects list 

Refresh List refreshes the shown list of Query Objects fetched from the 

repository 

Save Saves any editing work done on the Query Object 

Save As Saves currently edited Query object with a new ID (auto-generated) and Name 

in repository. You can choose a different folder location to save.  

If you are saving an existing Query Object with a new name, check “Copy Access 

Rights” under Options to copy the same rights to this new Query Object. You 

can also add Description to the Query object 

Connections Helps to specify a Parent connection 

Advanced Please refer the Advanced Properties section in this document 

Revert Reverts to the last saved instance of the Query Object 

Delete After a confirmation prompt dialog, deletes currently opened Query Object 

from repository. This action is not reversible 
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4 Advanced Steps 

Merging two sources using Join/ Union 

Intellicus Query Objects support two types of merging of data sets. 

1. Join – includes Equi and Outer joins 

2. Union – union of equal and unequal number of columns 

 

Join  

This step takes two inputs. When the data is passing through this step, the data of both inputs will be joined 

based on properties set for this step.  

Figure 12: Join Step 
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The Join step properties are: 

Property Values Comments 

Select All Fields Check/Uncheck 

 

 

Check = All fields from both the sources will be 

available in the output of this step 

The duplicate field names will be automatically 

renamed (suffixed with a underscore and number), 

example: if there is a common field named “Status” in 

multiple data sources that are joined, the names 

become Status, Status_1, Status_2, and so on  

Uncheck = You can choose which fields should be 

available in the output of this step 

Choosing is done by selecting the checkbox adjacent 

to field names of both inputs 

Join Type Select from: 

Inner Join 

Left Outer 

Right Outer 

Full Outer 

Select the type of join from the available list 

 

 

 

 

Join Conditions Field name Operator Field 

Name 

Forms the Join Key 

 

Union  

Union step takes two or more inputs. The data passing through this step appends to one another and forms 

a single output. 

Generally, the data inputs selected for Union are of same structure i.e. the columns are same. But this step 

supports exceptions and allows having extra columns in some inputs. You can decide whether to carry 

forward the fields coming from only some inputs to output. 

During the union process you can decide to take out the sorted or you can prefer unsorted appending.  
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Figure 13: Union Step 

 

The properties of Union step are: 

Property Values Comments 

Union Type Unsorted 

Sorted 

 

The output of this step shall be sorted or not 

 

Sort Priority Number 1-3 This property is at field level. 

This is set below the field name. 

Set the number 1, 2 or 3 to the fields which should be 

sort key 

Sort Criteria Ascending 

Descending 

Sorting criteria as either ascending or descending 

order 

Remove 

Duplicate Rows 

Check/Uncheck Check = To get distinct rows from Union step 

Column Type Yourself The selected field name populates automatically. 

You can change the caption of the resultant field.  

You can perform the actions on columns as mentioned 

in the below table 
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Action Button Comments 

Add Column  To add a new column  

Rename Column  To apply typed name to the selected column 

Delete Column  To delete the selected column 

Query Objects with Dynamic Fields 

Dynamic Fields Step 

Dynamic Fields step allows you to get flexibility of adding or removing fields to a Query Object at run time 

based on your meta information. 

Using this step, you can:  

1. Add dynamic fields by Pivoting data from input Data Source 

2. Dynamically fetch meta data for field properties 

 This step takes one input Data Source. 

Figure 14: Dynamic Fields Step 
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Dynamic Metadata 

This step takes an SQL or other Data Source that defines the metadata of the dynamic result set at run time. 

This SQL will be fired just before fetching the input Data Source. 

The Field Attribute Mapping section takes each field from the metadata result set and maps it to Query 

Object field properties. 

The important mappings are Field ID, Field Name, Caption and Data Type. 

 

Pivoting 

Pivoting allows you to convert highly normalized, Name Value paired data into flattened tabular data. 

Pivot Columns: specifies which column has field ID and which column has value. 

Select Grouping: specifies grouping fields, when grouped on which, the normalized data converts to flat 

table. 

Custom Step 

External Task 

External task step allows you to call standard and custom 3rd party processes from within Intellicus Query 

Object. Some may be in-proc and some tasks may be sent to remote execution by appropriate bridge 

components. 

There are few pre-configured external tasks. More external task types can be configured. 

Pre-configured external task types: 

Task Type Comments 

Custom MapReduce Job for 

Hadoop  

If you have custom-written scripts, you can use this option to execute 

such jobs  

Pig Job Jobs created using Pig scripts can be executed using this option  

Custom Row Processor You can create your own logic to transform your data using JAR files and 

provide it here  

Hive Job  Hive jobs can be executed, and results retrieved for analysis  
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Data Science Engine Step   

To perform the Data Science Engine step, you must have a Data Science connection formed to any of the 

Data Science Engines. The connection to a Data Science Engine is talked about in 

“WorkingwithDatabaseConnections.pdf”.  

The Data Science Engine step takes 2 inputs. This step helps you to transmit your data to Data Science 

Engines to perform machine learning and modelling. You can add Data Science Engine step before or after 

adding any other transformation step.  

Adding Data Science engine step at Query Object level helps you when predictions on your data are adding 

new variables and columns in tables. For example, in a market basket analysis, the clusters that would form 

may require new columns & variables in the table. This can be achieved while data preparation and hence 

such algorithms need to be defined at Query Object level. 

You can also perform Data Cleansing and other Data Science engine related transformation tasks by 

creating script at Query Object level.  

Data Science Engines train on your data to bring out predictions. You can input Training as well as 

Prediction data based on the below conditions while transforming your data.   

• If you have separate data to train and predict you need to add data for training as well as 

prediction.  

• If you want training and prediction on the same data, only one data source can be added.  

• If you already have a trained model in your script, you need not add training data. 

Figure 15: Data Science Engine Step 
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Properties 

Property Values Comments 

Data Source 

Engine 

R Job 

 

Here you can select the Data Science Engine you want 

to use 

Script Sample Script Here you can see the Data Science Engine script you 

have created 

Edit Type Yourself Click the Edit button to create Data Science Engine 

script or edit an already created one. 

When you click the Edit button, the script editor box 

opens. Here you can view the fields in your script and 

write R script for relevant fields. You can also verify 

your script to check if it is error-free.  

Guidelines for writing R Script  

1. The script needs to have sections for Training and Prediction. These sections should start with #. 

These place holders should be surrounded by <%%> for Intellicus to be able to parse and 

understand the modularization. For example, #<% TRAINING.SECTION %> 

2. The first line of the Training and Prediction script should be for reading the CSV and the last line of 

Prediction script should be for writing. Argument passed in the reading section should be <% 

Stepname.data %>  

Example,  

Read.csv(‘<% Train.data %>’) 

3. Previous step data should be referred as ‘StepName.data.’ For example, in the transformation area 

if you created the step as Train, the input must be ‘Train.data.’ 

4. The model created is by default saved as ‘myModel.’ This is a mandatory name to the model you 

create as it is referred to while communicating with Data Science engines.  

5. The training will only happen if the training script is provided, otherwise it will be assumed that a 

trained model is used.  

6. If a trained model is used, it is mandatory for user to provide a prediction script. 

Once you have added a script, you can click the Verify button to check if it is appropriately written. Click 

OK. You can further click Save or Save As to save your query object to use it in reporting.  

An example script for your reference is given below: 

#<%TRAINING.SECTION%>   

trainingDataset = read.csv('<%Train.Data%>') 

library(randomForest) 

myModel = randomForest(x = trainingDataset[1:15], y = trainingDataset$TEMP,ntree = 500) 
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#<%PREDICTION.SECTION%> 

predictionDataset = read.csv('<%Predict.Data%>') 

y_pred = predict(myModel,data.frame(predictionDataset[1:15])) 

predictionDataset$ExpectedTemp <- y_pred 

write.csv(predictionDataset , file='<%Predict.Data%>') 
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Data Extraction and Forwarding Agent (DEFA) Step 

Data Extraction and Forwarding Agent (or DEFA) collects identified data at predefined intervals from a data 

source and forwards it to a data collector component (Intellicus Report Server) which can transform and 

load this data. It gives you an ease of receiving only the incremental data as well.  

 

DEFA step in Query Object 

A DEFA step will be defined for receiving data from one or more DEFA agents. 

For defining a DEFA step, you need to have a snap shot of data that can be received by this DEFA step. This 

sampling data is used to understand structure of data that will be sent by configured DEFA agent(s) for this 

step.  

You need to specify a connection for metadata for designing a query. This would help DEFA know which data 

to fetch. This data can come from RDBMS, JSON and file based (TXT, CSV) data sources. 

Figure 16: DEFA Step 

The properties to be defined for DEFA are mentioned in the underneath table. 

Property Values Comments 

Connection for Metadata Select from list Connection to be used to design query 

for metadata.  

Select from already created connections 

on the Configure>Databases tab  
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Incremental Column Select from list Identity column for DEFA to extract 

incremental data 

Schedule Data Extraction 

Start at 

Select from list Start time for DEFA to fetch(extract) data 

Data Extraction 

Interval 

Type Yourself (as 

hr:min:sec) 

Time interval after which DEFA should 

fetch data 

Data Forward 

Interval 

Type Yourself (as 

hr:min:sec) 

Time interval after which DEFA should 

send (forward) data to Report Server 

Field Properties 

Property Values Comments 

Data Type CHAR, 

NUMBER, 

DATE, 

BINARY 

Select the data type of the incoming data 

Data Format Format String Specify the format of the incoming data. This is useful only if 

Date or IP Address type data are incoming in CHAR fields but 

needs to be converted to Date and Number types for further use 

Sort Priority Number 0-N If the data is sorted on multiple fields then specify sort priority 

number of this field. 

Primary sort field should be the lowest number 

Sort Criteria Ascending/ 

Descending 

Specify sort as either ascending or descending order 

Length Type yourself Length of field for Char data type 

Scale Type yourself Scale or number of digits after decimal point 
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Database Time Zone Select Time 

zone from the 

list 

Specify the time zone in which the incoming date data is stored. 

This is useful only if date time data needs to be converted to 

other time zone data based on reporting requirement.  

For example, when incoming GMT data need to show EDT (or 

any requested TZ) value in report, specify that the incoming 

data is GMT. The output format is generally specified in Format 

step or in user preference 

Locale Select from 

the list 

Select the language/ country in which the incoming date data is 

stored 

Qualified Name Type yourself This name helps using the field name in all the SQL clauses such 

as WHERE and ORDER BY or to resolve field name ambiguity 

when same field comes from two tables or expressions 

Load Step 

Load step under Query Object loads the incoming data (after extraction and transformation) into a target 

system (File, Relational database, HDFS, No SQL / Columnar system etc.). 

You need to select a target Intellicus connection (already created under Configure > Databases) on which 

data should be loaded. One of the important configurations is the unchecking of the 'Read Only' setting of 

the target system. If not unchecked, this will not show in the list of target system where the extracted data 

can be loaded. 

There are target connection specific properties required to load data into the system. 

You can fetch list of existing Tables/Files from the connection. 

Figure 17: Load Step 
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The properties of Load step (in case target system is an RDBMS) are: 

Property Values Comments 

Target Connection Select from list Select a target connection on which data 

should be loaded 

Table 

Properties 

 

 

 

 

 

 

 

Target Table Name Select from list Select target table name using the 

selected Target Connection 

If Table Exists Select from list: 

 

Append Data 

 

Delete Existing 

Data 

 

Skip Load 

 

 

Drop and Create 

New Table 

 

Truncate Existing 

Data 

Action to be performed in case table 

exists: 

 

To append data in the end 

 

To delete data in existing table 

 

 

To not perform any action on table and 

skip load step 

 

To drop the table and create new table 

with same name and new schema.  

 

To delete data in existing table, but 

Admin user can roll back this data  

Suffix TimeStamp Check/Uncheck Check= suffix timestamp in the chosen 

format to table 

 

Select from the available list 

Data 

Properties 

If Record Exists Select from list:  

 

Insert Only 

Action to be performed in case record 

exists: 
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Update Only 

 

 

Update or Insert 

Insert the new record 

 

Update the existing record with the new 

 

In case of an existing record, update it 

with the new record 

Else insert the new record 

Ignore Empty Rows Check/Uncheck Check= ignores empty rows in table 

while loading 

Error 

Handling 

Error Threshold Type Yourself Specify count of error after which 

loading process should stop. 

Any positive number>0 means stop 

processing after that many +1 errors i.e. 

if its value is 2, stop processing upon 3rd 

error. 

Column 

Properties 

Fetch Schema Click the option Fetches schema of the existing table 

You can see the field details of the data 

to be loaded under Column Properties 

section 

Remove All Columns Click the option Removes all columns in the target table 

 

You can run and schedule Query Objects which are of Load type from under Explorer. 

Load step can also be followed by the Data Source step further followed by Format step to be used for 

generating reports. 

Note: To know about loading into file, HDFS, NoSQL (Columnar) system, please refer 

WorkingwithLoadStep.doc 
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5 Query Object Properties 

Connection 

Query Object at the top level has two properties: 

Property Values Comments 

Name Type yourself Name of the Query Object 

Connection Select from list (Default) = Use default connection available at 

run time based on priority of user selection or 

server configuration 

Connection Name = Always run using this named 

connection, irrespective of user selection 

Access Rights 

Access rights on a Query Object can be granted to everyone, selected organizations or select users. Access 

rights given at Query Object level supersede folder level access rights. 

Access rights applicable to Query Object (as specified under Navigate > administration > Manage Users > 

Access Rights) are: 

Access Right Comments 

Read User can see the definition of the Query Object 

User cannot edit, delete the Query Object 

User cannot run reports using this Query Object 

Write User can delete, edit the Query Object. 

This right when given at folder level, user can create new Query Object 

in that folder, provided user has Data Administrator system privilege 

Execute User can execute reports using this Query Object. 

User can create new reports using this Query Object 
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Advanced Properties 

Advanced properties can be set at each Query Object level to control the behavior of the Query Object and 

reports generated using this Query Object. Click Advanced icon on the main menu to open the list of 

properties as discussed below. 

Figure 18: Advanced Properties 

Property Values Comments 

Audit Log (Default) 

Enable 

Disable 

You can switch ON or OFF audit logging for reports 

generated using this Query Object, irrespective of 

global audit logging setting 

Run Priority (Default) 

Low 

Medium 

High 

Decides the priority in the request queue of Report 

Server 
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Database 

Connection 

Timeout 

Type Yourself Overrides the same property value at connection or 

global level 

Data Source 

Fetch Size 

Type Yourself Overrides the same property value at connection or 

global level 

Max. Rows Type Yourself Maximum rows restriction from this Query Object.  

Report level Max. Rows value can further downsize, 

but that cannot upsize this value 

Query Execution (Default) 

Synchronous 

Asynchronous 

 

Asynchronous = Useful to free rendering thread when 

database is taking long time to process the data 

before it starts sending data in. 

Example: Heavy sorting at database, Complex 

procedures processing data before sending data 

 

Synchronous = thread waits after sending database 

request till data returns 

Restrict To 

Background 

(None) 

Enable 

Disable 

Enable = Reports using this Query Object shall be 

allowed by submitting to Run in back ground only. 

Useful for long time taking Query Objects. 

Disable = Both Run and Run in background options 

will be available. 

This facility is dependent on scheduler licensing 

Restrict To 

Formats 

(None) 

List of available formats 

(None) = reports using this Query Object can run in all 

supported formats 

Selected Values = Reports using this Query Object will 

be allowed to run only mentioned formats. 

 

For example, a report with few million rows in the 

output may be ok only in XLS and Raw text formats 

Default Memory 

Usage Per Exec 

Type Yourself Overrides the same property value at connection or 

global level 
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Report Server 

Chunk Timeout 

Type Yourself Overrides the same property value at connection or 

global level 

Sort Area Size 

Per Exec 

Type Yourself Decides the number of records that can reside in 

memory for all sort threads of a report 

 

Overrides the same property value at connection or 

global level 

Sort Threads 

Per Exec 

Type Yourself Decides thread limitations set for in-memory sorting 

of rows. 

Overrides the same property value at connection or 

global level 

Data Caching Enable 

Disable 

Enable= To create a copy of data in local data store 

retrieved by a Query Object for in-view and post-view 

operations of a report up to a specific time 

Update Fields At 

Runtime 

Enable 

Disable 

Enable = If database query returns new fields at run 

time, this Query Object exposes all the fields to the 

user on Ad hoc Wizard or Power Viewer 

 

Data Cache 

Data Cache creates a copy of data in local data store retrieved by a Query Object using a specific set of 

business parameter values for a specific user. This can be re-used for in-view and post view operations of a 

report up to a specific time. 

The cache is created from result set of Query Object and re-used for in-view and post-view purposes that are 

automatically identified to work from this result set.  

The operations that would re-use cached data are:  

1. Add/Modify/Remove filter  

2. Add/Modify/Remove highlighting 

3. Add/Modify/Remove grouping 

4. Add/Modify/Remove sorting 

5. Add/Modify/Remove Charts, Matrix 

6. Load lookup values derived from main result set 

The Data Cache life is determined by DATA_CACHE_PURGE_TIME (in minutes) property in Server Properties. 

This is set to 30 minutes by default. 
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Caution 

1. When Query Object returns large data set with business parameters but filtered to small set with ad 

hoc filters, then enabling Data Cache is not recommended. The first run of reports could be too 

slow.   

2. Dynamically constructed Query Object SQLs may cause cache to be used even when new fields are 

added in in-view process resulting in incorrect result set. Enabling Data Cache is recommended 

only for static fields Query Objects. 

3. Data Cache can be re-used across report run requests depending on matching of business 

parameters and Cache Purge Time.  

4. Local data store may not support some field nomenclature; you may have to rename Query Object 

fields by aliasing or other means to comply with local store, in such case. 

 

Update fields at Run time 

Adding newly returned fields from a SELECT * type of SQL or a dynamic result set returning procedure to 

Query Object at run time is achieved by this property. 

The newly added fields do not get saved in the definition of the Query Object permanently. The newly added 

fields are available in transient at each run time. 

 

Caution 

When Query Object is marked for Update fields at run time, then the Query Object may have to be executed 

more than once to find newer fields, causing slowness.
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6 Appendix 

A) System parameters and their values 

• Priority: low, medium, high. 

• Report Format: SYS_REPORT_FORMAT (to use the format of the report from where hyperlinked 

report is run), HTML, ACROBAT PDF, COMMA SEPARATED, TEXT, MS EXCEL, SMART, INTERACTIVE, 

MS WORD. 

• Report Connection Name: Select the database using which the report should be run. 

• Save File Name: File name to be used if the file is published as implicit operation. 

• Implicit Operation: In addition to view the file, if report needs to be published, select Publish. 

• Refresh Data: Select True to run report with latest data. Select False to run report with cached data. 

• Prefetch Drilldown: To start generating hyperlinked report even if user has not clicked hyperlink to 

run the report. 

• Pagination: Select the right option as per need to break pages by Single Page (increase page width 

and length to any size), Multiple Page (divide in width, divide in length as per need) and Horizontal 
Breaks (divide in length only, increase width to any size).  Available only for: MS Excel, Acrobat PDF 

and HTML. 

• Show HTMLtoolbar: When viewed in HTML, set Yes to have HTML Toolbar, set No for not having 

toolbar and set Multipage to have toolbar only if report is extended to more than one page. 

• Append To Parent (For PDF): Choose to append the child report output to parent report when the 

report with hyperlinked field(s) is run in pdf. 

• Parent/Current Map Level: These properties are used to map levels of GIS Maps in case of drill down 

maps.  


